ACCESSDATA SUPPLEMENTAL APPENDIX

Using File Filter Manager in FTK 1

One of the most powerful features of AccessData® Forensic Toolkit®
(FTK®) is the database upon which it is built. When FI'K analyzes a hard
drive, it creates a database entry for every item it finds (files, directories,
OLE objects, email, boot records, file slack, deleted files, etc.). After FTK
has entered the file data into the database, you can easily sort and
organize the information.

As a computer forensics examiner, you often have to wade through
enormous amounts of data to find small fragments of evidence. It is not
uncommon for a single hard drive to contain 250,000-plus files. If a case
contains 10-20 hard drives, you might have to sort and organize millions
of files and emails. A database is perfectly designed to store, sort, and
filter huge volumes of information and is, therefore, ideal as a base for
computer forensics investigations.

Once file data has been loaded into the database, you must have a
method of sorting and filtering the database to retrieve only the
information needed. The File Filter Manager is designed specifically for
this purpose.

This appendix introduces the File Filter Manager and provides
information to help you manage filters in FTK 1.

* “Overview” on page 2

* “Single Criteria Filters” on page 3

* “Multiple Criteria Filters” on page b

e “Creating a Default Filter” on page 7

e “Choosing a Filter” on page 7

¢ “Ignoring Data” on page 8

¢ “Applying Filters in the Overview Tab” on page 8
¢ “Applying Filters in the Search Tab” on page 8
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OVERVIEW

You can open the File Filter Manager by clicking View > File Filter
Manager.

You can also click the File Filter Manager button on the toolbar

The File Filter Manager filters information based upon four primary
criteria:

e File Status

¢ File Type

e File Size
e File Date

File Filter Man.;(ger

Selected filter: | Unfilterad v Active filter.  Unfiltered
File Status File Type Legend
J KFF Alert Files J Documents ﬂ Hide: Newver show files meeting
J Bookmarked ltems J Spreadshests these criteria
J Bad Extension J Databases
J Encrypted Files J Graphics E Shows Ahways show files

meeting these criteria unless

J E-mail ltems J E-mail messages overridden by Hide
J Deleted ltems J Exacutable Files
J Fiecycled ltems J Archives ﬂ Conditional Hide: Don't show

files meeting these criteria
J Folders

J OLE Subiterns unless overridden by Show

J Duplicate kerms

J Flagged lgnare
__| KFFIgnorable Files

J Slack/Free Space
J Other Known Files
J Unknown Files

J Conditional Show: Show
unless otherwise overridden

File Size File Date

J L

Close

The File Filter Manager allows you to either Hide or Show various file
items based upon the file data criteria information. The File Filter
Manager has four settings (listed in order of priority):

Setting Function

Hide Never show files meeting these criteria.

Show Always show files meeting these criteria unless
overridden by Hide.

Conditional Hide Don’t show files meeting these criteria unless

overridden by Show.

Conditional Show Show unless otherwise overridden.
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Because a single record item can be affected by several filter criteria
simultaneously, it is helpful to think of the four filtering conditions as an
embedded “if” statement.

if (one of the file criteria = Hide), hide the file item and break; else go to
next line

if (one of the file criteria = Show), show the file item and break; else go
to next line

if (one of the file criteria = Conditional Hide), hide the file item and
break; else

if we get to this point, show the file.

SINGLE CRITERIA FILTERS

A single criteria filter is the easiest type of filter to build. For example,
you can use a single criteria filter to find all the spreadsheets in the case
or perhaps all the files that had some kind of activity during a specific
period of time.

The easiest way to build a single criteria filter is to start by setting every
File Type option to Conditional Hide, as shown in the following graphic.

File Filter Manager

Selected filter: | Single Filter v Active filter  Single Filter
File Status File Type Legend
KFF &lert Files % | Documents

J J g Hide: Newer show files meeting

J Bookmarked lterns ﬂ Spreadsheets these criteria

J Bad Extension ﬂ Databases

J Encrypted Files ﬂ Graphics H Show: e Sh.DWf”eS
meeting these criteria. unless

J E-mail lterns ﬂ E-mail messages ovaridden by Hide

J Deleted ltems ﬂ Executable Files

J Recydled ltems ﬂ Archives ﬂ Caonditional Hide: Dan't show
files meeting these criteria

J OLE Subitams ﬂ Folders unless overridden by Show

J Duplicate lterms

J Flagged lgnore
___| KFFignarable Files

ﬂ Slack/Free Space
ﬂ Other Known Files
ﬂ Unknown Files

Conditional Show: Show
unless otherwise overridden

File Size File Date

J L

Save as ] l Delete
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Alternatively, you can start building a single criteria filter by setting File
Size to Conditional Hide. In the from box, enter 0 bytes and in the to
box, enter an enormous value like 1000 MB.

File Size
ﬂ (@) Logical
() Physical
from |0 bntes W

to (1000 ME W

Your objective is to create a filter that filters out all the files in the
database.

After you have accomplished this, you are ready to set the items you
want viewed to Show. For example, if you want to see all the encrypted
files in a given directory, set Encrypted Files to Show and set all the File
Type options to Conditional Hide, as shown below:

File Filter Manager

Selected filter. |Encrypted Filas ~ Active filter:  Single Filter
File Status File Type Legend
KFF Alert Files % | Documents
J J ﬂ Hide: Newer show files meeting
J Bookmarked! fems ﬂ Spreadsheets thase criteria
J Bad Extension ﬂ Databases
Encrypted Files ﬂ Graphics Shm"f: Always Sh.DWflles
meeting these criteria unless
J E-mail lterms ﬂ E-mail messages averridden by Hide
J Deleted ltems ﬂ Executable Files
J Pecydled lterns ﬂ Archives ﬂ Conditional Hide: Don't show
. files meeting these criteria
J OLE Subitsms ﬂ Folders unless overridden by Show
J Duplicate ltems ﬂ Slack/Free Space
J Flagged lgnore ﬂ Other Known Files J Conditional Show: Show
§ . unless otherwise owverridden
J KFF Ignorahle Files ﬂ Unknown Files
File Size File Date
i Save as.. ] [ Delete ] ’ Save/Apply ] | Close

Then you can go to the directory and apply the filter.
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MULTIPLE CRITERIA FILTERS

Multiple criteria filters are more complicated because they require the
use of all three conditions: Hide, Show, and Conditional Hide.

The following graphic shows how to create a filter that displays all
graphics files that are in email.

File Filter Manager

Selected filter. |Graphics in E-mail

w Active filter:

File Status

|| KFF Azt Files
J Bookmarked ltems
J Bad Extension
J Encrypted Files
E-mail ltermns

J Deleted llems

J Recycled tems
__| OLE Subitems
J Duplicate tems

J Flagged Ignore
__| kFFIgnarable Files

File Size

|
[ ]
]

File Type

ﬂ Documents

ﬂ Spreadshests
ﬂ Databases

ﬂ Graphics

ﬂ E-mail messages
ﬂ Executable Files
g Archives

ﬂ Folders

ﬂ Slack/Free Space
g Other Known Files
ﬂ Unknown Files

File Date

]

Single Filter
Legend

ﬂ Hide: Newer show files meeting
these criteria

Showe Always show files
meeting these criteria unless
overridden by Hide

ﬂ Conditional Hide: Don't show
files meeting these criteria
unless overridden by Show

Conditional Show: Show
unless otherwise overridden

i Sawve as..

] ’ Delete ]

| Save/Apply | ’ Close
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Multiple criteria filters can be as easy or as complicated as you need. For
example, a complex filter could be one that displays all documents with
a creation date between 8/1/02 and 8/15/02, are larger than 10 KB,
and have not already been flagged as ignored, bookmarked, or part of
the KFF database. The following graphic shows what this filter would
look like.

File Filter Manager

Selected filter: |Large Documents v Active filter: Single Filter
File Status File Type Legend
J KFF Alert Files ﬂ Docurments . §
g Hide: Newver show files meeting
ﬂ Bookmarked ltems ﬂ Spreadsheats these criteria
J Bad Extension g Datahases
J Encryptad Files ﬂ Graphics Sho\p\f: Alwarys sh_ow_flles
meeting these criteria unless
J E-mail ltems g E-mail messages overridden by Hide
J Deleted tems ﬂ Executable Files
J Recycled ltems ﬂ Archives ﬂ Conditional Hide: Don't show
. files meeting these criteria

J OLE Subitems ﬂ Folders unless overridden by Show
J Duplicate tems ﬂ Slack/Free Space
ﬂ Flagged Ignore ﬂ Other Known Files J Conditional Show: Show

. . unless otherwise overridden
ﬂ KFF Ignorable Files ﬂ Unknown Files
File Size File Date
ﬂ %Loglca\ Files @ Created O Modified OAccessed OWith any date

Fhysical

|8/ 172002 3| ang | 81572002 2|

from -bytes w (O] LUEL
1o Ointhe last l:l

’ Save as... ] ’ Delete ] [ Save/fApply ] I Close
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CREATING A DEFAULT FILTER

During everyday operation, many investigators create a default filter that
is usually set. This filter automatically filters out files that have already
been bookmarked or flagged as ignored, are OLE streams, or are part of
the KFF database. Many times this filter is called (for lack of a better
name) Default Filter. The following graphic shows a default filter.

File Filter Manager

J Duplicate ltems
ﬂ Flagged lgnare
ﬂ KFF lgnarable Files

Selectedfilter: | Dafault Filter v Active filter.  Default Filter
File Status File Type Legend
J KFF Alert Files J Documents . .
ﬂ Hide: Mewver show files meeting
ﬂ Bookmarked ltems J Spreadsheets these criteria
J Bad Extension J Databases
J Encrypted Files J Graphics H Show AluEys sh_ow_flles
meeting these criteria unless
J E-mail kems J E-mail messages overridden by Hide
J Deleted lterms J Executable Files
J Recycled ltems J Archives ﬂ Conditional Hide: Don't show
files meeting these criteria
ﬂ OLE Subitems J Folders unless overridden by Show

J Slack/Free Space
J Cther Known Files
J Unknown Files

J Conditional Show: Show
unless otherwise overridden

File Size File Date

L L

Save as... |’ Delete

CHOOSING A FILTER

FIK includes several basic filters, but you can quickly expand this list by
creating your own filters.

Filters are global. In other words, after a filter is created, it is available
for use in all the cases that run on that computer.

The active filter is displayed in the text box next to the File Filter
Manager button, as shown below.

& BN Defautt Fiter

The red ON sign indicates that a filter is active. The ON sign changes to
OFF when Unfiltered is chosen.
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IGNORING DATA

The ability to ignore data is one of FIK’s most helpful features. After a
file has been reviewed and determined not to contain evidence, you
need to be able to flag the file Ignore so that you don’t accidentally
encounter the file again. The File Filter Manager allows FIK to filter out
files that have been flagged Ignore.

To ignore a file, highlight or checkmark the file. Then select either
Tools > Ignore Highlighted Items or Tools > Ignore Checked Items.
Ignore Item is also available from the quick menu when you right-click a
selected file.

Hidden items are then removed from the case for further analysis by
enacting a filter that includes the setting to hide Flagged Ignore files.

APPLYING FILTERS IN THE OVERVIEW TAB

In the Overview tab, the summary results can be filtered by selecting the
Filtered button, as shown below.

Unfitered

Unfiltered and Filtered reflect only in the Overview tab.
APPLYING FILTERS IN THE SEARCH TAB

In the Search tab, filters are applied to the search results during the
searching process. After entering your search terms, FTK displays the
following menu:

Files to Search
() Allfiles

() Checked files
(®) Filtered files

Filter narme: Diefault Filter hd

By selecting Filtered files and choosing a filter, your search results pass
through the filter before they are reported.
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